Pyramix 12 Release Notes

Installation

Please consult the Installation Guide located on the Pyramix Installation Media (USB Memory card) for details on the hardware and software installation procedure and Authorization Key registration process.

RAVENNA users will have to install the NET-MSC-GBEX1 PCIe Ethernet card provided by Merging Technologies. TURN YOUR COMPUTER OFF (shut down then switch the power off). Next plug the NET-MSC-GBEX1 card into one of the PCI-Express bus slots on your computer and turn the power back on. The NET-MSC-GBEX1 card will only be operational once the MassCore runtime is installed. Refer to the Pyramix Installation Guide for more details.

- To install the Pyramix Virtual Studio software insert the Pyramix Virtual Studio Installation Media - the installation program should auto-start.
- To install MassCore launch the MT Security Settings, go to the MassCore page and install the MassCore RunTime (a MassCore base key is required along with MassCore 64bit and a RTX64 3.0 key). Refer to installation guide for more details.
- Warning: Make sure that the Windows 10 version you are installing onto is supported by Pyramix, as often update can break the compatibility. All details in the separate Pyramix installation guide.

Updates

Please check our Web site http://www.merging.com periodically for information, patches and updates.
**Pyramix v12 INSTALLER INFORMATION:**

Pyramix v12 is compatible with the following Operating Systems

- Windows 7 Professional (64bit): MassCore/RAVENNA, Native & Native/RAVENNA ASIO
- Windows 10 Professional (64bit): MassCore/RAVENNA, Native & Native/RAVENNA ASIO

Note: Pyramix v12.0 is supported under the Windows 10 updates;
- Anniversary (1607)
- Creator (1703)
- Fall Creator (1709)
- Spring Creator (1803)
- October update (1809)
- May update (1903) supported as of Pyramix v12.0.5 HotFix

As well as the Meltdown and Spectre Windows updates.
- Windows 10 Zombieload update is supported with MassCore/RTX64 3.6.2 and 3.7.0

**WARNING:** Pyramix v12 is supported on 4th Generation Intel Core Processors (4XXXX and higher) and will not launch on previous Processors generation

Recommended specification:
https://confluence.merging.com/pages/viewpage.action?pageId=24608853

**Pyramix v12.0 installation notes**

- Pyramix v12. requires new Pyramix v12 keys are mandatory
- Pyramix v12.0.5 HotFix come with a NEW MassCore RTX64 v3.7.0.4983
- The Pyramix v12 installer comes only as a 64bit version (64bit OS)
- Before you perform a Windows 10 update to Windows Fall Creator (1709) or Spring Creator (1803) or October update (1809) on a system already running a MassCore version it will be important for users to remove MassCore from the MT Security MassCore tab prior to performing a system update. Details below.

*Take note that when selecting uninstall MassCore you will need to reboot your system as the uninstallation is completed during the system reboot*

*Note #1: We highly recommend users to defer the Windows updates, so that it does not harm your system [here for details on how to defer updates](https://confluence.merging.com/pages/viewpage.action?pageId=51118318)*

*Windows 10 users should never update to Beta Windows version or major new updates before making sure they are supported by Merging.*

*Note #2:*

*Users wanting to update to Windows October update (1903) must follow the procedure [here](https://confluence.merging.com/pages/viewpage.action?pageId=51118318)*

*Users that apply Windows updates must refer to the Merging Compatible Windows updates [here](https://confluence.merging.com/pages/viewpage.action?pageId=27852814)*

*Once you have updated your Windows 10, follow the Pyramix v12 and MassCore installation.*

- SSK-HUD-RTX owners can have both a Pyramix v11 or v12 MassCore key and eventually Pyramix v12 MassCore Key stored on their dongle and go from a system to the other using their SSK-HUD-RTX
- SSK-HUD-RTX owners should be aware that the Hasp driver 7.80 is not compatible with MassCore/RTX64. Refer to the procedure [here](https://confluence.merging.com/pages/viewpage.action?pageId=27852814)
- Pyramix v12 Projects are not backward compatible with Pyramix v11.1, users must perform a “Save Special as v11.1“ in order to open such project in v11.1

**Native Installation Notes:**

- Pyramix v12.0 requires new Pyramix v12 keys are mandatory
- Pyramix v12 can be installed on either Windows 7– 64bit or Windows 10 – 64 bit
- The Windows 10 update 1903 is supported as of Pyramix v12.0.5 HotFix
- It is necessary to remove the previous Pyramix version, if there is one, from the Windows Programs and Features, and then reboot your system before installing Pyramix v12
- Follow the Pyramix Installation Guide for all details
- RAVENNA ASIO v12 > is mandatory to update to firmware 3.9.4 and higher and vice-versa.
- As of v11.1 the ANEMAN installer is no longer included in the Pyramix Installer.

Please download and install the latest ANEMAN in order to manage and monitor your AoIP devices from [http://www.merging.com/products/networked-audio/aneman](http://www.merging.com/products/networked-audio/aneman)
MassCore Installation Notes:

- Refer to the Pyramix v12.0 Installation Guide for installation procedure and details on the specific BIOS settings and system configuration.
- Pyramix v12.0 uses a new MassCore version RTX64 v3.7.0.4983 as Pyramix v12.0.5 Hotfix
- Pyramix MassCore users need a RTX64 3.0 key in order to Install and run MassCore. See with your Merging Sales Partners.
- It is necessary to remove the previous Pyramix version, if there is one, from the Windows Programs and Features, and then reboot your system before installing Pyramix v12. Take note that when selecting uninstall MassCore you will need to reboot your system as the uninstallation is completed during the system reboot.
- Unless you are planning to update to: Windows 10 Creator (1703) or Fall Creator (1709) or Spring Creator (1803) or October update (1809) or May (1903) when it is recommended to first remove MassCore before performing the update. In such case follow the procedure document:
  https://confluence.merging.com/pages/viewpage.action?pageId=51118318
- After installing Pyramix v12 MassCore users might need to uninstall their previous MassCore from the MT Security setting, MassCore Tab, depending on the previous Pyramix version you were running. If there is an older version present you will be warned and required to reboot before updating to the latest version.
- If your Pyramix system never had a MassCore version before, users will have to install the new MassCore version from the MT Security Settings > MassCore tab.
- Users running MassCore 64bit will not be able to move their license to another system (or the same system after a Windows re-installation) unless first making this demand through Merging keys@merging.com. Please justify the reason of your system migration or reinstallation as the RTX64 key is not meant to be frequently renewed.
- If Merging cannot follow up in a quickly enough (in case of emergency or during weekends) then please contact the Interval Zero (RTX) Sales team sales@intervalzero.com
  Note: MassCore/RTX 64bit keys are linked to the system/hardware.
  MassCore users can have their MassCore/RTX 64bit keys stored on a separate Dongle instead of having it linked to a unique system. Refer to the Merging option SSK-HUD-RTX.

Pyramix v12 users must refer to the Pyramix v12 Installation Guide for more details
https://www.merging.com/support/downloads#pyramix

Warning:

- Windows 7 users could see this error: “ Installation of KB3033929 has failed”, potentially this update is already installed, proceed with YES
- Additional Online installation notes are available here:
  https://confluence.merging.com/display/PUBLICDOC/Installation+Notes+v11

Merging Windows 10 Configuration Guide
https://confluence.merging.com/display/PUBLICDOC/Windows+10+Configuration

Note: At the Pyramix launch a warning message box will be displayed if your system updates settings are not configured upon Merging’s recommendations.

Merging Windows 10 -1903 update & Configuration Guide
https://confluence.merging.com/pages/viewpage.action?pageId=51118318

Notes:

- Anubis must be running ASIO v12.0.1 and higher with ANEMAN 1.1.7 and higher.
- For users with Pyramix and VCube installed on the same system, it is mandatory that you upgrade to VCube 8.0 to run alongside Pyramix v12.0
- MassCore RTX64 users upgrading their processor on a system that was running MassCore previously must follow a specific procedure, contact support@merging.com for more details.
- A MTCleanUp v11 utility is available through Merging’s Support for those having problems with their installation
  Please refer to the Knowledge Base
  https://confluence.merging.com/display/PUBLICDOC/MT+Cleanup
**Pyramix 12.0 Release Notes**

- Pyramix v12.0 requires new Pyramix v12 keys are mandatory
- Pyramix v12 projects are not compatible with Pyramix v11.1, use the new Save Special as v11.1 in order to open a v12 project in the previous v11.1.
- Native users running Horus/Hapi on Firmware 3.9.4> must install and run the RAVENNA ASIO driver v12.0.2 and higher.

**MassCore :**

- Pyramix v12 comes with a new MassCore Version RTX64 3.7.0.4983 supporting Windows 10 May 2019 update 1903 (19H1).

**Features**

**Ambisonic support:**

Pyramix 12 now includes a complete hybrid Channel Based/Ambisonic workflow, allowing for encoding, mixing, rotating and decoding Ambisonic signal directly in the mixing console.

- Ambisonic up to the 7th order is fully supported, refer to VR Pack key information for all details. Internal Ambisonic channel numbering and normalization is AmbiX/SN3D.
  
  **Note:** use plugin for A to B format and Fuma to AmbiX conversion

- The contextual menu in the Mixer for Strips > Add > Multi Channel Strip now offers the 7 Ambisonic orders in the Channel Mapping list.

- The contextual menu in the Mixer for Bus > Add > General Mixing Bus now offers the 7 Ambisonic orders in the Channel Mapping list.

- If a Channel based Strip crosses an Ambisonic Bus then the channel-based signal is encoded to Ambisonic and panned using the traditional Panner. Two additional sliders for Azimuth and Elevation are also displayed in this case in the Surround Panner window. A-Pan is displayed in the bus control component for the given Strip and Bus to indicate Ambisonic Panning. No Channel Routing is available in this case.

- If a stereo or multichannel Strip crosses an Ambisonic Bus then the channel-based signal is encoded channel per channel to Ambisonic and panned using the traditional Panner using the same options (balance, dual pan, single pan with source size, etc...). Two additional sliders for Azimuth and Elevation are also displayed in this case in the Surround Panner window. A-Pan is displayed in the bus control component for the given Strip and Bus to indicate Ambisonic Panning. No Channel Routing is available in this case.

- If an Ambisonic Strip crosses an Ambisonic Bus, there are two options available in the bus control, A-Mix and A-Rot.

- A-Mix simply displays a diagonal in the Channel Routing window. This is for advanced usage. Keeping all values to 0.0 is recommended.

- A-Rot displays a rotation tool both in the Panner bus and in the Surround Panner window. This allows rotating the Ambisonic Strip (the input scene) in the Ambisonic Bus (the output scene).
• If an Ambisonic Strip crosses a Channel based Bus, then an Ambisonic Decoder is applied and the Ambisonic signal is decoded to the Speaker Set (or Channel Mapping) of the Bus.

• As for mixing, a choice is available to apply rotations before decoding (A-R+D), or only decoding (A-Dec)

• Ambisonic Strips display an Ambisonic logo in the Panner bus for this strip and controls the Z rotation (see below).

• The Surround Panning window (menu View > Windows/Tools > Surround Panner or CTRL + Click on the Panner Bus) now displays an Ambisonic logo as background if an Ambisonic bus is enabled for the selected Strip.

• If both a Channel based bus and an Ambisonic bus are enabled for a given Strip, both the Ambisonic logo and the traditional Room Cube showing speakers are displayed.

• In the Surround Panner window when an Ambisonic bus is display (showing the Ambisonic logo) a light Blue circle is played following the White square pan point. This is the Azimuth/Elevation equivalent of the X/Y/Z point, with a Radius of 1.0, being the intersection of a straight line between the pan point and the center of the sphere crossing the surface of the sphere. This is the Ambisonic Panned point.

• The Surround Panning window offers a new Display Mode button allowing toggling between the traditional Top and Back views, a new Top and Cylindrical View and a new Cylindrical View only.

• When manipulating the Cylindrical View, the Azimuth and Elevation is affected by the movements and the Radius is automatically maintained to 1.0, ensuring both the traditional panned point and the Ambisonic panned point to be located on the scene surface.

• When pressing CTRL while manipulating the Cylindrical View, the traditional panned point is forced to stick on the edges of the X/Y/Z cube (instead of the sphere) and therefore always moves on a straight line between speakers. This allows using the Cylindrical View in an optimal way when panning Channel based signal.

• The ADM export available in the Mix-Down properly exports Ambisonic related information.

**Ambisonic Decoders:**
• Ambisonic Decoders supported up to 7th in v12, and the b<>com Decoders are now integrated within the Pyramix mixer

**Additional changes:**
• The Standard Speaker Sets list (Channel Mapping list) available when creating a new Bus or a new Multi-channel Strip has been reorganized to match the latest industry standards. Most ITU-R BS.2051-1 recommendation for loudspeaker configuration are now included in this list.
• The Add Audio Track menu in the Timeline now offers the Standard Speaker Sets list when creating a new multi-channel Track & Strip

**New VR Pack Key option:**
• Ambisonic Strips and Ambisonic Groups of 1st and 2nd order are always decoded even if the VR Pack key is not present
• Ambisonic Strips and Ambisonic Groups of 3rd to 7th order are properly decoded if the VR Pack key is present
• Ambisonic Strips and Ambisonic Groups of 3rd to 7th order are decoded using a 2nd order decoder if the VR Pack key is NOT present

**Notes:**
• Ambisonic Strips and Busses can be created by the contextual menus of the Mixer or configure page
- Ambisonic Bus channel types cannot be changed.
- External controllers can be used transparently to pan Ambisonic when encoding/panning
  Channel based to Ambisonic, the exact same controls are used. However Ambisonic Rotations
  use the rotations controls and should then be mapped separately to external controllers

**Known limitations:**
- The Divergence control has no effect in Ambisonic Encoding/Panning for now
- Pyramix Mixer currently does not allow multichannel connections for an Ambisonic input Strip
  for remote MicPre. Please use the Web Access PreAmps page for Horus and Hapi
V12 Improvements

General Master:
The Generate CD Image / SACD Edited Master entry has been replaced by the Generate Master.

Master Settings section:

<table>
<thead>
<tr>
<th>Type</th>
<th>Sampling Rate</th>
<th>Resolution</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Book CD Image (PMI)</td>
<td>44.1 kHz</td>
<td>16 bit</td>
<td>Mixdown</td>
</tr>
<tr>
<td>DSD Edited Master (DSDDIF)</td>
<td>DSD64 (SACD) - DSD128 - DSD256</td>
<td>1 bit</td>
<td>Mixdown - DSD Rendering (DSD project)</td>
</tr>
<tr>
<td>PCM Digital Release (MTFF)</td>
<td>44.1 - 88.2 - 96 - 176.4 - 192 - 352.8 (DXD) and 384 k</td>
<td>24 bit - 32 bit float</td>
<td>Mixdown</td>
</tr>
<tr>
<td>DSD Digital Release (MTFF)</td>
<td>DSD64 (SACD) - DSD128 - DSD256</td>
<td>1 bit</td>
<td>Mixdown - DSD Rendering (DSD project)</td>
</tr>
</tbody>
</table>

New:

Initialization of the Generate Master Settings behavior change, to restrain manipulation errors. Now the last parameters of the Generate Master dialog are retrieved, but the Master Type/Settings are initialized in accordance with the default project values.

Examples:
- project 44.1k = Red book CD Image (44.1k 16 bit)
- Project PCM 48k/176.4k/192k/352.8k/384k = MTFF PCM Digital Release 24 bit set to the project sampling rate
- Project DXD = MTFF PCM Digital Release 32bit float 352.8k
- Project DSD64/128/256 = MTFF DSD Digital Release en DSD Rendering set to the project sampling rate

Digital Release now allows users to generate DSD128 and DSD256 Edited Masters in either DSD rendering or Mixdown mode, this also allows DSD128 and DSD256 input formats for Album Publishing.

The DSD Rending mode requires that you first select the number of channels to render.
MTFF DSD Digital Release Generation is new as of Pyramix v12 and can be imported in the Album Publishing or DiscWrite.

MTFF also now includes the MTFF loss-less compression option for Generate Master.

Note: MTFF lossless compression is available for linear PCM resolutions only and not for floating point PCM

Mixdown Processing section:
- The users to perform Realtime or Non-Realtime Mixdown depending of the Master Type selected
- The DSD Edited Masters now includes the DSD Sigma Delta Modulator settings (when in Mixdown Mode)

Post Processing / Album Publishing:

**New DST encoding to Album Publishing DSD Edited Masters option**
- When performing a DSD Edited Master from the Album Publishing you will see a checkbox option allowing the user to make the DST encoding in the pass.
  - From Windows Explorer Right click > properties on a DSD/DST DSDIFF file in the windows Explorer shows a DSD/DST info tab
  - Within Windows Explorer the DST and DSD medias will have different icons.

**DSD128 and DSD256 Edited Masters Generation**
- As of Pyramix v12 users can generate DSD128 and DSD256 Edited Masters when entering the Album Publishing with a Dsdx Digital Release Master no PCM step will be processed if you deliver Dsdx media tracks from it (e.g. DSD256 Master generation to DSD256 media tracks)
DSD Rendering (Project DSD Render and Generate Master):

- New feature (Process DSD at original Sample rate) now allows performing DSD Rendering processing (Gain and crossfades) at the original DSD material sample rate (i.e. 64 Fs for DSD64, 128 Fs for DSD128, 256 Fs for DSD256)

New Meco Sigma Delta Modulator available in Album Publishing

- The new Meco SDM (available in the SDM section of an output format) allows high sample rate (64 and 128 Fs) intermediate multibit stage when from a DSD format to another (e.g. DSD256 to DSD128)

Note: Pre-Sigma Delta Gain and Post SRC Gain now supported for DSD formats

Import MTFF Digital Release:

As of Pyramix v12 users can now import their MTFF Digital Release into the Pyramix timeline and edit the CD tags if corrections are needed, the workflow is similar to PMI CD Image / SACD Edited Master / SACD Cutting Master Import, includes artwork import dialog windows is resizable. Select under the Project menu Import>MTFF Digital Release.
DiscWrite:
- Users can now edit the Metadata of MTFF files, as per screenshot below. When editing the Metadata you will be asked to save or replace your source master file.
- DSD MTFF Digital Release supported in Discwrite (can be use to create DSDIFF Edited Masters)
- During the Beta cycle we recommend that users’ backup their MTFF master file prior to editing

![Screenshot of DiscWrite](image1)

Authoring Text Validation and Report generator:
A text validator is now available to ensure that a final verification is performed prior delivering to your customers or replication plant the final Master.
This validator supports CD and SACD XTOC formats, and will ensure that the character sets and used characters are respecting the Final Master specification
- Text validator available in Pyramix
  - Text validation will be done when selecting from the View menu “Display TOC”
  - If errors in your authoring text are found that will be reported at the top of the TOC view
  - Error information and eventual faulty character position indicated within the error line report

*Example in Pyramix, where an error is reported along with its position.*
Text validator available in Discwrite
- The Text validation will be done at the Image or Digital release opening
- If an error is found the user will be able to view the error report file (.txt)
- The faulty character set and error position will be indicated within the error report
- The reported error can be corrected within Discwrite for either PMI or MTFF imports by entering the Edit view.

**Example in Discwrite, where an error is reported along with its position**

![Discwrite interface with error report and Edit mode](image-url)
New CD text import feature (CDTEXT.BIN)

CD Text have a separate file in the DDP folder, usually named CDTEXT.BIN, which carries the raw CD-Text data ready as it would be written on a CD. It is now possible for users import this data in Pyramix CD Text Tab (CDTEXT.BIN) and retrieve CD text for a current loaded CD within Pyramix.

- The CD Text only will be re-imported (no markers nor timestamp) and will fill the existing CD tracks to the current CD and will not create new tracks.
- If No tracks are present in the current CD, only the Disc info in relation to CD text will be imported

As of v12.0.5 HotFix the Disc Title (Not CD-Text) can be edited from the DiscWrite Edit mode. Allowing the user to correct and invalid character entry outside of the CD-Text content.
New SACD Cutting Master generation feature

Replaces the former SACD CM wizard present in v11.1 and prior.

This new dialog is available through Pyramix’s Project menu when at least one valid SACD disc is available in the current project.

It focuses on preparing the generation of an SACD Disc Builder script for SACD cutting master generation through a clear single dialog user interface.

For each disc, the user has to provide the following inputs:

- One or two DSD64 Edited master (DST encoding can be performed on-the fly if needed)
- A disc Name
- A couple target folders for the future SACD Cutting master output

Careful validation of the provided data (source data files, Table of contents, Text metadata) is performed at each state and clearly notified to the user.

Once the script is generated, the user can choose to automatically proceed to the actual Cutting Master generation in the external SACD Disc Builder application.
Mixer improvements:

As of Pyramix v12.0.5 HotFix.

Bus Sends
- Mixing console General Aux/Group Busses Send Gain now allowed to go up to +12dB.
- When send value is above 0 dB both the dB text indicator and slider turns to light red.

Bus Trims
- Mixing console General All Busses Trim Gain now allowed to go up to +20dB.
- When trim value is above 0 dB the dB text indicator turns to light red.
- Double click on any trim value reset to Mute if clicked on left side, or 0dB if clicked on right side

Pyramix v12.0.4

New Custom IO setup feature available in the routing view of VST/VST3 plug-ins (as of v12.0.5 HotFix)
- User now can decide to change the IO setup of a plug-in. This can be useful workaround for plug-in's limitations such as:
  ▪ a plug-in supports only mono, stereo, and 5.0 surround channel setup but the insert strip is 5.1 Surround: setting the Plug-in to 5.0 surround IO setup will workaround the default stereo fallback IO setup and LFE channel will be unprocessed by the plug-in
  ▪ a plug-in supports up to 7.1.4 Atmos channel setup but the insert bus has 9.1.4 Atmos channel set: setting the Plug-in IO setup to 7.1.4 Atmos will allow processing most channels and avoid falling back to default stereo IO setup.
- Right clicking on the plug-in's node now displays a popup menu allowing the user to manually configure a plug-in's input and output channel layouts.
- The dialog lets the user pick any layout among the Mixer supported channel sets. If the plug-in IO change is successful, the routing view will reflect the changes and auto-connect the matching channel types to the input and output section; otherwise the IO setup of the plug-in will remain unchanged.
- If the user decides to switch back to default IO configuration policy which follows the strip/bus channel layout and falls back to stereo or mono when not applicable, the same popup menu offers a "Reset Plug-in's Custom I/O setup" entry to do so.

VCA Strips can now be moved anywhere in the Input Strips portion of the Mixer
- Aux Group Strips can now be moved anywhere in the Input Strips portion of the Mixer

- The General Mixing Bus section of the mixing console can now be operated as a big Matrix Grid.
  - Clicking on any On/Off button of the Send components and keeping dragging the mouse on any direction will create a diagonal patching (or unpatching) on neighbour components.
  - Pressing the CONTROL key while doing so will create a rectangular block of On/Off instead of a diagonal. Useful for quick unpatching of a region.
  - This feature is best used when the complete mixer is collapsed, both strips and busses, however still functional if some strips or bus are not.

- Route page Save/Load
  - Added a Load and Save buttons in the Mixing Console Routing Page
  - This loads and saves the current console inputs, outputs and direct out routing from/to an XML file

New Mixer scrolls
- Added Mouse Wheel support in the Pyramix/Ovation mixing console.
  - Without modifiers the Busses are scrolled
  - With CONTROL modifier the Input Strips are scrolled if the mouse pointer is in the input strips area, or the Master Strips are scrolled if the mouse pointer is in the master strips area.

- Masters and Busses can now be scrolled like Input Strips were in previous versions
  - Grabbing the Mixer LEFT border now reduces the Input Strips portion and those hidden can be scrolled
  - Grabbing the Mixer RIGHT border now reduces the Masters Strips portion and those hidden can be scrolled
  - Grabbing the Mixer TOP or BOTTOM border now reduces the Mix, Aux and Groups portion and those hidden can be scrolled

- The bottom right contextual menu available on the [+] button now offers new entries:
  - Console > Reveal All: To maximize the Mixer window to reveal all Input Strips, Masters and Busses
  - Input Strips > Scroll Half: To reduce the currently visible Input Strips portion by half
  - Input Strips > Reveal All: To maximize the Mixer window to reveal all Input Strips
  - Masters > Scroll Half: To reduce the currently visible Masters Strips portion by half
  - Masters > Reveal All: To maximize the Mixer window to reveal all Masters Strips
  - Busses > Scroll Half: To reduce the currently visible Mix/Aux Busses portion by half
  - Busses > Reveal All: To maximize the Mixer window to reveal all Mix/Aux Busses

  This menu has been reorganized to show the entries in the following order:
  - Console
  - Input Strips
  - Masters
  - Busses

  An additional section has been added to this menu:
  - Faders/Effects/Pan
    - Show All
    - Hide All
    - Collapse All
  This allows quickly Hiding/Collapsing and Showing back all Faders, Mutes, PreAmps, Effects and Pans at once to focus on a maximum of Busses available in the mixer height

- Mixer VST plugin Split by Columns layout option, to display all plugins at once instead of having them in flapping dialogs.
Warning not all plugins might show up in columns if you have installed a very large plugins suite.

- Mixer: New Predefined Speaker Sets available
  - 9.1
  - 7.1.6
  - 9.1.2
  - 9.1.4
  - 9.1.6

General improvement
- A menu and toolbar button “Clips > Disable Groups” has been added to temporarily disable existing clip groups for easily selecting a single clip in a group.
- All clips envelopes movements are now rounded to .5dB.
- Selecting entire clips using the SHIFT key now allows clicking within a clip and not only outside of clips as previously.
RAVENNA ASIO Driver v12.0

Added AES67 latencies settings for 6 and 12 samples support

Warning: Users installing RAVENNA ASIO v12 > or VAD 2.0.39648> must update to the latest Horus and Hapi Firmware 3.9.4 and above

ANEMAN 1.2:
This new ANEMAN (Audio NEtwork MANager) version, include the following features.
- New: MERGING+ANUBIS support
- New: ZOEM support
- New: support for Unicast
- Discovery improvements
- Zone Improvements
- Quick access menu improvements
- Improved stability
- More details on www.aneman.net

ANEMAN v1.2.1 Bugs fixed:
- macOS Mojave 10.14.x Support
- Improvement. Enhanced plugins discovery
- Improvement. Device coloring for matrix
- Improvement. Receiver deletion
- Improvement. Device error now reported in the Matrix
- Fixed. Plugin and Proxy installation issue
- Fixed. Disabled Dock mode per default
- Reliability fixes.

Important: The ANEMAN comes as a separate installer.
Please download and install the latest ANEMAN in order to manage and monitor your AoIP devices from https://www.merging.com/products/aneman

Warning: RAVENNA Easy Connect is not supporting MERGING+ANUBIS, it is recommended to use ANEMAN to manage your Anubis AoIP network connections
Fixed Bugs in V12.0.5 HotFix:

- New: MassCore RTX64 3.7.0 update as of Pyramix 12.0.5 HotFix
- Improvement. MassCore performance and PTP synchronization mechanism
- PMX111-72: Fixed. Mixer/Record: Some mixer can become corrupted with wrong assignation to tracks in record
- PMX111-234: Fixed. Mixer: Converting DSD project to DXD will put Legacy busses
- PMX111-292: Fixed. DXD Mixer converted to DSD (for SACD) can become invalid and
  Organize page is not reachable Wizard not intuitive
  - Proper mixer setup for DSD to DXD project conversion
  - Pyramix AudioEngine fix to make Auto-Repro work again when punch Rec setting is disabled
- PMX120-85: Fixed. Media created by mixdown with Dubbing mode setting enabled won't appear in Media Manager without a refresh and will remain with an "Edit while recording" status (red)
- PMX120-93: Fixed. Markers tab - Create CD Disc moves the timeline clips if markers not aligned on CD frames
- PMX120-100: Fixed. Mixer: Custom Plugin IO setup for user from the routing view (right click on plug-in node)
- PMX120-103: Fixed. Using Mixer Wizard DSD will make sampling rate change impossible
- PMX120-104: Fixed. Regression: DST encoding slower in v12
- PMX120-107: Fixed. Metadata import padding issue
- PMX120-110: Fixed. External Inserts makes PMX crash in some projects
- PMX120-111: Fixed. Mixer Configure page resets the routing of Native Plug-ins instances
- PMX120-113: Fixed. Record-enabled tracks won't play back when their monitoring is set to Auto in Source-Destination projects
- PMX120-114: Fixed. Cursor Auto-Return after Playing returns to position cursor was located at when the project was last saved
- PMX120-118: Fixed. VST routing Crash Pyramix on some plugins when opening Routing configuration
- PMX120-122: Fixed. Secondary Audio Device crashes Pyramix when clicking Apply Changes or OK buttons
- PMX120-129: Fixed. Ambisonic Panner movement sticky if you have multiple buses
- PMX120-134: Fixed. Windows 1903 Configuration Message
- PMX120-135: Fixed. DiscWrite: the DDP generation will add 2 sec of silence at start of burned CD
- PMX120-136: Fixed. Wrong characters displayed in Media Management > Quick Convert > Normalize >Properties > Level dBs
- PMX120-138: Fixed. Selection of clips lost when shift-clicking to select/deselect multiple clips
- PMX120-147: Fixed. Global TOC data truncated when generating DDP's in DiscWrite
- PMX120-157: Fixed. Save special broken
- GAIA-1020. Fixed. Mixdown with Metronome and SRC active makes Pyramix crash
- GAIA-1059: Fixed. Metronome no sound on 1st bar
- Fixed. Ovation/MassCore/ASIO playback buffer size initialization issue
- Fixed. Some SD track Groups project cannot record. Those must be typed as Source or Destination
- Fixed. Minor enhancements to CD Authoring metadata validation:
  - added "Disc Title (not CD Text)" field to the PMI/MTFF editable fields in DiscWrite (to be able to fix eventual invalid character in the DDP Disc Title field
  - more flexible UPC EAN code validation. if the field contains only spaces characters, it is still valid
- Fixed. DSD Project creates Multichannel strips without PreAmps remote control
- Fixed. A crash when starting playback on a S/D project without any selected track groups
- Fixed. SACD Cutting Master dialog did not launch the SACD Disc Builder application when asked to do so once SACD LBM script got successfully generated.
- Fixed Bonjour (Un)Install prerequisites
- Improved editing reliability to prevent random crash (Ovation)
- Fixed. Fixed crash in Discwrite when opening PMI CD Image with more CD-Text longer than 160 characters
- Fixed. DSD Render dialog: sample rate combo box was not populated if project was PCM and 352k
- Fixed. Room 3D Speaker set setup when dealing with discrete channel types
- Fixed. Mixer configure page fix: Adding Stereo or mono strip does not take the specified channel types into account
- Fixed. Album Publishing: Optimization
- Fixed. limitation for Ambisonic
- Fixed. Mixer scrollbar contrast
- Fixed. Bus sends improvements (goes to +12dB with level indicator)
- Fixed. Bus trims improvements (goes to +20dB with level indication)
- Fixed. Select Next/Prev Track Group for collapsed Track Group now selects the top track of the group and not the displayed

**Fixed Bugs in V12.0.4:**
- PMX120-84: Fixed. MassCore overloads due to Mixer graphics
- PMX120-85: Fixed. Wrap hangs and fails with some projects
- PMX120-86: Fixed. Native 29.97 TC output not stable (ASIO)
- PMX120-91: Fixed. Discwrite does not reload PMI or MTFF metadata after editing them
- PMX120-92: Fixed. Mixer corruption when removing Strips and clicking in Mixer.
- PMX120-93: Fixed. Markers tab - Create CD Disc moves the timeline clips if markers not aligned on CD frames
- PMX120-96: Fixed. One file per track - Suffix with strip name lose tracks when recording if strips have the same name
- PMX120-97 Fixed. Some VST/VST3 plug-ins such as Youlean return two different state sizes
- PMX120-98 Fixed. Machine: Adding machine (e.g Sony 9 Pin) will crash Pyramix
- PMX111-222: Fixed. Pyramix crash when changing the Media Manager View form details to Large View at the folder root
- Fixed. Various display bugs
- GAIA-861: Fixed. Enable undo in Fade Editor and Update waveform color options makes PMX crash
- GAIA-1197: Fixed. Pyramix crash when BWF Metadata is enabled and using same rendered file name
- Fixed. Source/Destination Track Arming from Mixer improvement (Track arming affecting selected trackgroup tracks now)
- Fixed. DXD to DSD project conversion
- Fixed. Added Strip Name and Track Name in the Matrix Window
- Fixed. Splashscreen text loading scrolls down and not visible
- Fixed. Album Publishing DSD Modulation level computing (same results as Pyramix Media Manager DSD Annex D3).
- Fixed. DSD multi-channel interleaving
- Fixed. DSD Modulation level measures
- Fixed. issue with DSDIFF Edited Master input when no comment is present in the provided file

**Fixed Bugs in V12.0 RC1:**
- PMX111-132. New: Raw CD Text data import in Pyramix Authoring Tab
- PMX111-235. Fixed. Album Publishing: Invalid Input or Output Format error cannot process
- PMX111-350: Fixed. Pyramix hangs when mixing down using an already-used file name and the Wrap in Video option
- PMX120-57: Fixed. Mixer>Routing Save/Load preset support
- PMX120-65: Fixed. Album Publishing Missing target format such as DSF, random.
- PMX120-67: New. Added Transparency Check plugin in VS3 listing
- PMX120-69: Fixed. Undo after CDTXT.BIN import not working on Disc Info
- PMX120-76: Fixed. CM import Audio data Import failed (Desectorizer error)
- HEL-736: Fixed. Mixdown when file already exist
- RAV-976: Fixed. ASIO driver debug trace disabled (performance was impacted)
- RAV-987: Fixed. SSM requires IGMPv3: disabled by default and move to an Hardware option (Horus, Hapi, Anubis)
- Fixed. RAVENNA ASIO driver issue with PreAmps controls

**Fixed Bugs in V12.0 Beta2:**

- MSC-72: Fixed. Pyramix V12 beta 1 - RTX3.6 install not working on Windows 7 if the update KB2921916 is not present (we've added this update to the Pyramix installer)
- PMX111-346: Fixed. File duration discrepancy when doing sample rate conversion on Wave files
- PMX111-352: Fixed. Effect Rack crash due to remaining reference to ghost plugins
- PMX120-44: Fixed. Generate Master - DST encoding strategy not updating when changing area
- PMX120-47: Fixed. Generate Master: Missing DSD128 and DSD256 masters possibility in their native formats
- PMX120-48: Fixed. Mixdown settings overwrite record settings
- PMX120-52: Fixed. Advanced pages indicating wrong MassCore Sampling Rate
- PMX120-56: Fixed. Some DDP import could potentially hang at import.
- PMX120-68: Fixed. Speed up VST3 Shell plug-in instantiation
- Improvements to 3rd party ASIO Driver support at high sampling rates DXD/DSD (e.g. iFi)
- New. MTFF DSD Digital Release support available in Generate Masters entries
- Fixed. ASIO driver installation and uninstallation problems
- Fixed. Media Manager list display: fix to the MediaSize column sorting
- Fixed. Added MTFF loss less compression for Generate Master
- New. MTFF Digital Release can be imported to the Pyramix Timeline and re-edited.
- Fixed. Metadata bug fix for the creation of MTFF digital releases in Album Publishing (contiguous MTFF output format)

**Fixed Bugs in V12.0 Beta1:**

- PMX120-12: Fixed. Strips with more than 8 channels cause Delay Compensation to corrupt the Mixer and might randomly crash
- PMX120-19: Fixed. Mixer: Changing Ambisonic Bus order in configure Page does not update the 3D room
- PMX120-23: Fixed. Mixer improvement for large mixers
- PMX120-32: Fixed. VS3 Control Panel: Limit number of assignable cores to MSC to 6 (which is the maximum supported by the Merging MassCore SMP key)
- PMX111-80: Fixed. Authoring: Exported 'Video TimeCodes File' text files can be empty of content due to illegal Disc Title Character
- PMX111-298: Fixed. Pyramix TOC view and export does not display the total track time
- PMX111-312: Fixed. Pyramix Wrap fails with error (new warning added to Wrap utility)
- PMX111-313: Fixed. Mixer Fader alignment parameter not correctly recalled after saving and opening project
- PMX111-323: Fixed. FXRendering: changing the IO setup to smaller number of channels can cause invalid connections inside the graphic
- PMX111-335: Fixed. Album publishing does not give "No Change" option in sample rate menu for WAVE format
- RAV-922: Fixed. Software devices: WebApp reconnects forever (due to MassCore NIC network interface custom name)
- PMX120-52: Fixed. Wrong MassCore sampling rate in Advanced Settings pages
- MSC-65: Fixed. MassCore: Ultra and Extra Low Latency, in DXD, will cause an RTSS issue when in SMP mode
- MSC-66: Fixed. DSD project improved spreading over SMP cores
- MSC-67: Fixed. RTX64 not properly uninstalled from MT Security Settings>MassCore tab
- MSC-72: Fixed. RTX64 install not working properly without running MT Security as admin
- Fixed. Oddity with UPC/EAN check sum digit calculation and verification 38124. Fixed. Tipro keyboard support for Windows 10 -1809
- New. RefClk PTP traceable
  This feature is useful when you want to connect a stream through Internet (e.g. with two PTP Masters (GPS) at each locations), it allows to make connections with devices locked to different traceable PTP Masters.
- Ovation/Pyramix ADR keyboard (Tipro) supported for latest Windows 10 (1809)
- Fixed. Improved VST and VST3 stability
- Fixed. Advanced RAVENNA Settings Pages. Session sink were not accepting source name characters
- Fixed. Advanced RAVENNA Settings Pages. Session Source: "enabled" property not restored during boot
- Installer Update. SeaMax SDK update from v3.3.2.1 to v3.4.0.1
Pyramix v12 Product Changes:

- New v12 keys are required as or Pyramix v12

**WARNING:** Pyramix v12 is supported on 4th Generation Intel Core Processors (4XXXK and higher) and will not launch on previous Processors generation

Recommended specification: https://confluence.merging.com/pages/viewpage.action?pageId=24608853

- New MassCore version based on RTX64 v3.7.0 adding support for the Windows 10 – May update (1903) and Zombieload updates (as of Pyramix v12.0.5 HotFix). This new version remains of RTX64 3.0 key based.
- New VR Pack Key for decoding Ambisonic Strips and Ambisonic Groups of 3rd to 7th order
- New VS3 Flux plugins EVO CHANNEL and EVO IN, available with new key option
- Pyramix v12 project are not backwards compatible. A new save Special as v11.1 was added.
- As of v12 the Pyramix Mixer MicPre Amps will have as option; Mic, Line and instruments (Instruments is supported only with MERGING+ANUBIS)
- Pyramix v12 MassCore and Native support Windows 10 – 64 bit as well as keeping the Windows 7 -64bit support
- Custom install option is no longer available as of v12 to avoid improper installation
- The new default Recording and Mixdown format is BWF
- ANEMAN replaces RAVENNA Easy Connect, refer to the ANEMAN guide for more details and is no longer part of the installers, please download and install ANEMAN from here: http://www.merging.com/products/networked-audio/aneman
- RAVENNA Easy Connect is not supporting MERGING+ANUBIS. It is recommended to use ANEMAN 1.1.8 and higher.

MassCore Technical Notes:

- MassCore not supported on Core2Duo. Minimum requirement is a QuadCore. Find system recommendations here: http://www.merging.com/support/pc-config
- MassCore is supported under Windows 7 (64bit) and Windows 10 (64bit) with Pyramix v12
- MassCore as of Pyramix v12 requires v12 Keys a RTX64 3.0 Key and a new MassCore installation.
- MassCore 64bit: Activation key is linked to the system and not the dongle) and can only be activated once on a dedicated system. This only applies to 64bit. If you need to re-install MassCore/RTX64 bit on another system using the same key this will not be possible if the key has already been used. For such RTX64 Activation Key Replacements, the request can be made at keys@merging.com or in case of a weekend, emergency through the Interval Zero Support team IntervalZero Support site This means that if have you already MassCore 64bit on system and want to move it to another system you must contact Interval Zero and RTX64 so that they re-issue the key.
- In order to run MassCore 64bit users will need to have both the RTX64bit Activation key and the MassCore 64-bit key.
- MassCore Ultra Low latency mode can generate noise if used on some configurations (Turnkey recommended).
  In such cases we rather recommend instead the use of the AES67 mode or Extra Low latency mode.
- Pyramix Core indicator overloading (red) issue. Recommendation:
  - Under a 64 bit OS: MassCore RTX 64bit users are allowed to run with Hyperthreading enabled. In such case users will by default have 2 Core allocated to MassCore RTX64, as we leave a pair number of Cores for Windows.
  - Merging recommends to having an SMP key under such configurations.
  - If, under the Bios power options, you have entries such as the Intel SpeedStep and CPU C State make sure that these options are disabled, as they are potential problems for MassCore. Refer to installation guide or the Windows Configuration guide for all details.
- MassCore & CPU load indicator range (as of Pyramix v10.2 and above)
  - Green from 0% to 74% = Safe mode*
  - Orange from 75% to 84% = Moderate Risk*
  - Red from 85%->100% = High Risk
  *MassCore users will have enhanced Core stability when using recommended dedicated Graphic Cards.
  *Native users: Recent laptop owners are often confronted with performance problems when the CPU load is near the mid-point of load, where random CPU jumps can cause sudden glitches. This has also been seen when benchmarking with Non-Merging Applications on recent laptops.
- When the Core indicator blinks (red), it indicates a drop. Only be concerned if it occurred during Playback/Mix down or Record. To reset the Core drop simply click on the Core indicator. For more information please refer to the appropriate section in the User Manual.
- If you have VST Core peaks under MassCore, users should increase their VST Engine Buffer size value, located under the Pyramix Settings. More information is available in the User Manual.
- External Insert plug-ins: The same input and output cannot be used in the External Insert plug-in and the Mixer at the same time, as they are exclusive to either one.
V12 Known issue:

Merging online knowledge database for updates on the v12 known issues
https://confluence.merging.com/display/PUBLICDOC/V11+Known+Issues

- New MassCore/RTX64 key required as of v12.0
- The Windows 10 May update (1903) is compatible with MassCore/RTX64 -3.7 that comes as of Pyramix v12.0.5 Hot Fix and higher.
- WARNING: Pyramix v12 is supported on 4th Generation Intel Core Processors (4XXK and higher) and will not launch on previous Processors generation
  Recommended specification:
  https://confluence.merging.com/pages/viewpage.action?pageId=24608853
- Custom installation is known to potentially have issues at installation. We recommend that you install the recommended full Pyramix.
- Pyramix v12 Projects are not backward compatible with Pyramix v11.1, users must perform a "Save Special as v11.1" in order to open such project in v11.1
- Pyramix v12 projects with v10/v11/v12 Bus layout/Structure cannot be saved within a Save Special v9.0 project. A warning message will prevent you from doing so.
- All of the Mixer Amibsonic components cannot be saved within a Save Special v11.1 project
- Legacy Bus conversions to New General Bus. Due to the architecture of the new busses, mono mix busses are now converted to Mono Aux busses and not anymore to Mono Mix busses. Refer to the Pyramix User manual for more details.
- The listing of the Pyramix supported remote controllers is available here
- Mixdown SRC: The SRC option in the Mixdown is shared with the Media Manager Sampling Race Conversion tool. Be warned that following a Mixdown that is applying a SRC if you then use the Media Manager Sampling Race Conversion tool and change the SRC parameters, then those values will also be changed in the Mixdown Dialog Box SRC section.
- TANGO I or II Known issues:
  https://confluence.merging.com/display/PUBLICDOC/General+Bus+Ramses+and+Tango+support
- ISIS controller: New General Bus mapping must be done via the General Settings>project>Controller Mapping where the Bus numbering (order counting the strip) has to be added to the Channel Strip function dialog
- Pyramix Video in timeline: if the Video file is shown as offline at project opening, please refresh your media manager to regenerate the Quickmount
- Pyramix Video in timeline: Opening a project referring to multiple video files or edits can take some time (will indicate finishing for a minute or so), be patient.
- Merging does not recommend users that edit while recording do so with timeline media clips that are not at the same sampling rate as the project. This is because a realtime SRC will have be processed could cause potential performance problems.
- Waves plugins users running with an NVidia graphic card should make sure that they have the Threaded Optimization OFF, if set to ON it may cause issue with Waves VST plugins.
  Refer to link here:
  https://confluence.merging.com/display/PUBLICDOC/Graphic+cards+recommended+settings
- Merging does not recommend the use Disk models: Green, Eco series and Seagate.
- Merging recommends that users with External USB disks to have those configured using the "Better Performance" option under Windows disk properties, profiling tab. Refer to the Merging system configuration guide for more details.
  http://www.merging.com/support/system-configurations
- MassCore: Core indicator will show a peak/overload after a save on large project or when rebuilding the Mixer (project open-close). Simply reset the core indicator by clicking on it.
- VS3 Algorithmix DeNoiser & DeScratcher are supported but will not be maintained anymore
  Known issue: They might display “Demo” (while fully functional) until the first project is saved, closed & re-opened.
- Warning message "Not Enough Streams available": This happens when reaching the maximum number of record inputs. In such case we recommend that you reduce your input number count or disable any Background Recorders that are consuming inputs
  Known issue: If afterwards, you get a constant Message Box showing “Re-activating Project” at each Playback start, close and re-open your project to correct this.
- Pyramix v8.1, Pyramix v9.0, Pyramix v10, Pyramix v11 and Pyramix v12 Library formats are compatible between such versions but not with the previous Pyramix Releases. In order to open these libraries in an older Pyramix version please make sure that you use the proper Save library option. A “Save as Version 7.X” was added to the list
- Final Check Metering is not supported in DxD/DSD mode
- DiscWrite known issues: [https://confluence.merging.com/display/PUBLICDOC/Disc+Write](https://confluence.merging.com/display/PUBLICDOC/Disc+Write)
- Cannot install Pyramix Native: If you have an error and rollback, make sure that you unplug all dongles that could be connected to your system.
- Timeline and Realtime Sampling Rate Conversion: clicks may occur when doing playback or mixdown in a region where 2 overlapping clips refer to the same media with different sampling rate than the Project’s.
  - workaround: Convert those master clips to the project’s sampling rate in advanced
- The ADR Keyboard users:
  - Windows 10 October 2018 Update (1809) and the May update (1903) requires ChangeMe version 5.25.8. Previous versions will not work along those Win10 updates.
  - Follow the installation instruction on our knowledge base to update: [https://confluence.merging.com/display/PUBLICDOC/Pyramix+ADR+and+Ovation+keyboard+install+guide](https://confluence.merging.com/display/PUBLICDOC/Pyramix+ADR+and+Ovation+keyboard+install+guide)
- Safety Record issue with the take logger: Pressed commands will be applied incorrectly when the transport is stopped. This means that if you press Abort & Delete while in Safety Record, nothing will happen. However, when you come out of Safety Record and Stop, it will apply the command, and delete the take. Handle with care.
- Multiple projects opened simultaneously: We do not recommend users to have more than 8 Projects open at the same time (due to GDI object limitation).
- Cedar users should install the latest certified version for Pyramix v11/v12 64bit [https://confluence.merging.com/display/PUBLICDOC/Cedar+Renderer](https://confluence.merging.com/display/PUBLICDOC/Cedar+Renderer)
- The Render Tool will create a temp file for the CEDAR and Nova v0.99 at the root of the C:\ Be aware that Merging cannot change the Temp file path of such a third party Render.
- Interchange: A non-embedded AAF export to Pro Tools 7x could generate “Could not complete your request because an unexpected error happened while trying to find an audio media file’s format” error message. We recommend the use of AAF Embedded when exporting to ProTools 7. ProTools 8 known to be working properly in this case.
- Media Recoverer and DSDIFF Recoverer, those utilities should allow you to repair a corrupted file [https://confluence.merging.com/display/PUBLICDOC/Media+Recoverer](https://confluence.merging.com/display/PUBLICDOC/Media+Recoverer)
- Eucon/Euphonix version 3.6 can be installed alongside Pyramix for 64bit users

**Media Manager and Library recommendations and changed behaviors**

- The Database Location path is set under Settings>Application>Location>Default Database Location. Otherwise the database path will be C:\Documents and Settings\<User Name>\Application Data\Merging Technologies\Pyramix
- For better performance Merging strongly recommends that you move the Database location to your fastest system Drive. SATA2 - 7200 rpm Disks are recommended any disk other that the C:\OS default drive will perform better since it will have lower demands placed upon it.
- \Merging recommends that your Disks have the indexing disabled and that you make sure that the Power Management is set accordingly for better performance.
  - Disable File Indexing:
    1. Open “My computer”
    2. Right click on each drive and select “Properties” from dropdown menu
    3. Un-Check the indexing check box
  - Verify the Power Management:
    - Go under Windows Control Panel and open Power options
    - MassCore users Under Windows 7 and Windows 10: Power plan should be set to: “RTX – recommended”
    - Native Users: Make sure you select the “High Performance” power plan
- For ultimate performance Merging recommends that you (not mandatory)
  - Set your Antivirus to off while running Pyramix
  - Set Winodws Automatic-Update to “Never Notify”
  - Avoid active internet connection while running Pyramix
- Keeping Mounted Folders when closing and restarting Pyramix can speed up your workflow: Set the option under All Settings>Application>General> “Mount all media folders that were Mounted at previous Application Exit”
- You can clear the History of the Media Manager under the Media Manager>Media Folder menu, or simply disable the Keep Media Manager History option located in the Pyramix Settings, since this will clear the History at each Pyramix exit.
- Merging recommends Pyramix users save their project on a Disk were no OS resides for better performance (C:\ not recommended).
RAVENNA Technical Notes:
- Windows 7 SP1 (64bit) and Windows 10 (64bit) are supported by Pyramix v12 MassCore RAVENNA and Native
- Pyramix v12 system recommendations (Based on v11). Details here: http://www.merging.com/pages/pccconfig
- For ultimate performance we recommend that under ANEMAN you only connect the necessary I/O connections, as every extra RAVENNA connection will use some bandwidth (Core or Network)
- The Network must be Layer 3 compliant and must be a Gigabit network
- Merging has certified new Network Switches for use with Horus/Hapi – Ravana users will find all details along with the configuration guide here: https://confluence.merging.com/display/PUBLICDOC/Network+Switches+for+RAVENNA+-++AES67 http://www.merging.com/products/horus/downloads
- RAVENNA users should avoid connecting multiple Horus or Hapi units to any a router/Network not certified by Merging. Refer to the Merging RAVENNA Network Guide for details on the certified RAVENNA switches and their configuration. http://www.merging.com/products/horus/downloads
- Only RAVENNA devices can be connected to the Merging PCIe Ethernet Controller Card NET-MSC-GBEX1. Avoid connecting non-RAVENNA devices to this network, such as Tango/Isis/Euphonix controllers or other network devices.
- Don’t connect a 100MB Ethernet device if the switch is not multicast; otherwise the flow control will reduce the bandwidth drastically.
- A RAVENNA ASIO driver is available for Horus users that wish to use their notebook GbE Network RJ-45 system socket. Refer to http://www.merging.com/products/horus/downloads

RAVENNA Known issues:
- RAVENNA: Switching from MADI Standard (56) to MADI Extended (64) can generate a small glitch, so please avoid doing so during realtime operations
- Merging recommends the use of ANEMAN in order to manage all RAVENNA I/O connections, please refer to the ANEMAN User Manual installed with Pyramix for more details.
- Non-certified RAVENNA configurations might not be capable of sustaining 384 I/O channels @ 1FS (44.1/48 kHz). If you experience noise similar to static, reduce the RAVENNA I/O channel count enabled in ANEMAN. We also recommend that if you have experience such static noise, do not run MassCore in Ultra Low or Extra Latency mode but rather Low latency mode.
- Merging recommends that RAVENNA users disable the Windows Firewall, as it can partially block or otherwise interfere with some of the RAVENNA I/O connections
- Peaks might show up under the Pyramix Core section if you power OFF or disconnect the Horus/Hapi. Recommendation: A valid connection to an online Horus is always required if the Horus is PTP Master. Reset peaks by Mouse Clicking on the Core Indicator section.
- Avoid changing a network address, or disconnecting Ethernet ports on your system when MassCore RAVENNA is running
- The ISIS cannot be used when running RAVENNA with the Merging PCIe Ethernet Controller Card NET-MSC-GBEX1 Recommendation: Refer to the ISIS support document below http://download.merging.com/beta/SupportTools/Docs/AccessoryHardware/ISIS_Vista_or_7_dedicated_lan.pdf
- RAVENNA EasyConnect Troubleshooting tips are available here
- DSD issues
  - Background Recorders: If the Mixer is not a DSD compatible Mixer (square mixer), the record fails, but no message will be displayed. We recommend that users create a DSD project prior to enabling and starting to work with Background Recorders in DSD.
  - When creating/opening a DSD project the Horus might not switch accordingly between 64/128/256. This has to be done manually
RAVENNA I/O Connections:
In order to create RAVENNA I/O connections please refer to the ANEMAN User Manual (installed along with Pyramix)

Each Horus/Hapi will then appear in your ANEMAN application where you will see the name of each of them online. You will be able to dispatch each Horus/Hapi I/O connection from the ANEMAN Matrix. Refer to the ANEMAN guide installed along Pyramix for more details.

Windows Firewall:
The Windows Firewall can block communication between MassCore and Horus. We recommend users to disable the Public Network Firewall
Procedure:
2. Click on “Turn Windows Firewall on or off”
3. Go to the Public Network section and select “Turn Off Windows Firewall”

Windows UAC:
User should disabled the Windows User Account Control
Procedure:
1. Go to the Windows Control Panel\All Control Panel Items\User Accounts
2. Open the Change User Account Setting
3. And set it to “Never Notify”

Disable Antivirus:
Some Antivirus such as Avast or Sophos have been known to block the Horus discovery and RAVENNA I/O Connection. Merging also recommends that any Antivirus software is properly configured to not interfere with the DAW. See this page for further details: https://confluence.merging.com/display/PUBLICDOC/Antivirus+and+Merging+Technologies+Softwares
Pyramix Native Recommendations:

- Windows 7 and Windows 10 - 64bit supported with Pyramix, Ovation and RAVENNA ASIO v12.
- Please refer to our Windows configuration guides to optimize system performance.
- Administrator rights are required to configure VS3 Control Panel and the RAVENNA ASIO panel.
- The Merging RAVENNA ASIO Frame Mode size can be configured to AES67 (6, 12, 48) of RAVENNA mode (64), verify your network and devices configuration.
- The Merging RAVENNA ASIO driver can be set to buffer size multiples of 48 (AES67) or 64 samples (RAVENNA), adjust the buffer size to your system in order to get the best performance
- Configure your Antivirus and Merging Technologies Softwares or turn it off
- Configure your Windows Firewall Windows Firewall Troubleshooting or turn it off for Public Networks
- Put Windows UAC (User Account Control) to the lowest level (disabled).
- Disable the WIFI (disable the Wireless adaptor not only the WIFI connection)
- Disable Bluetooth if active (under Windows Device Manager)
- Set Windows Automatic-Update to "notify me" or don't let Windows check for Updates while running critical real-time operations on Windows 7
  - Set the updates to restart outside active hours on Windows 10.
- Avoid active internet connection while running Pyramix
- Avoid connecting audio interfaces to USB or Firewire hubs, plug it directly into your computer.
- We recommend to activate HyperThreading if allowed by your CPU.
- Power management features must be configured to get a stable system.
- In Windows Control Panel > Power Options, make sure you select the "High Performance" power plan (or "Ultimate Performance" on Windows 10 Spring Creator 1803 and October update 1809, 1903)(very common that Powerful laptop are at times in energy saving mode, create a High Performance power plan).
- Avoid using battery power, rather have you power cable connected
- Make sure all unnecessary programs are closed. They can tie up useful resources.
- Turn off any software utilities that run in the background, such as Windows Messenger, calendars, and disk maintenance programs.
- Laptops usually have small graphical resources, Merging recommends you pay extra caution when using the Fixed Cursor option.
- Verify the performance of your Native system.
  - On Windows 7 by running the DPC Latency checker: [http://www.thesycon.de/eng/latency_check.shtml](http://www.thesycon.de/eng/latency_check.shtml)
  - On Windows 10, DPC latencies can be monitored with Latency Mon [http://www.resplendence.com/download/LatencyMon.exe](http://www.resplendence.com/download/LatencyMon.exe)
- Laptop users should set their ASIO interface to Topmost Priority in VS3 Control Panel.

Refer to the online documentation for more details
[https://confluence.merging.com/display/PUBLICDOC/Native+recommendations](https://confluence.merging.com/display/PUBLICDOC/Native+recommendations)